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1. Klassik chiziqli modelni yaratish uchun ma`lumotlarini yuklash 

Uy xo`jaliklarining haftalik xarajatlari bilan daromadlari o`rtasidagi munosabatlarning 

iqtisodiy modelini tuzib olamiz va shu asnoda stata dasturida oziq-ovqat sanoatining 

dinamik ma`lumotlari asosida model tuzishga harakat qilamiz. Birinchidan Stata dasturini 

ishga tushuramiz va ishchi katalogini kiritamiz. Buning qanday qilinishi kompyuterning 

operatsion tizimiga va stata dasturining do-file lari joylashgan joyiga bog`liq. 

Ishchi katalog turi quyidagicha: cd “C:\Users\User\Documents\stata” yuqoridagi 

ishchi katalogni buyruqlar oynasiga kiriting va Enter ni bosing. Yoki Stata ochiladigan 

menyusidagi File > Change Working Directory katalogini tanlang. 

Yangi muammoga duch kelsangiz, ochiq bo`lgan har qanday jurnal faylini o`chirib 

tashlashingiz kerak. Yangi bir stata log faylini boshlash uchun uskunalar paneli belgisiga 

bosing. 

 
Bir kunlik faylingiz ochiq bo`lsa, sizga ba`zi imkoniyatlarni beradigan dialog paydo 

bo`ladi. Yangi jurnal faylini ishga tushirishdan avval siz eski faylni yopishingiz kerak. Yoki 



buyruq oynasida quyidagi buyruqni kiriting: 

log close 

Stataning xotirasini tozalash uchun quyidagini kiriting: 

clear 

 

2.1.1. Kundalik log faylni ishga tushirish va ochish  

Stata log faylini ishga tushirish yoki yopish uchun uskunalar paneli belgisiga bosing 

yoki quyudagi buyruqni kiriting: 

log using chap02, replace text 

Ushbu log fayli mavjud katalogda matn formatida ochiladi. Variantni almashtirish 

chap02.log ning avvalgi versiyasiga yozilib, o`chiriladi. 

Izoh: Foydalanuvchilar har bir bo`lim yoki bo`limning bir qismi uchun log faylini 

ochishlari kerak. Oldingi boblar uchun log fayllarini ochish va yopishni sizga eslatib 

qo`yamiz, lekin keyingi boblarda bajarib bo`lmaydi. Kundalik log fayllardan foydalanish 

odat qiling. 

Oziq-ovqat xarajatlari misoli haqidagi ma`lumotlar stata nomli faylida va food_exp 

faylida joylashgan. Stata ma`lumotlar faylini ochish uchun uskunalar panelidagi Open 

(foydalanish) tugmasini bosing 

 
food_exp.dta toping, uni tanlang va Open tugmasini bosing. Yoki buyruqlar oynasida, 

joriy papkadan ma`lumotlar faylini ochish uchun quyidagi buyruqni kiriting: 

use food_exp 

Agar Stata xotirasini bir vaqtning o`zida yangi ma`lumotlar faylini ochish hamda 

tozalash zarur bo`lsa, quyidagicha buyruqni kiriting: 

use food_exp, clear 

Oldindan ochilgan ma`lumotlar to`plamini xotiradan o`chiradi. Biroq, yangi 

ma`lumotlar faylini ochishdan oldin "tozalovchi" ma`lumot faylini amalga oshirish 

xavfsizroqdir. 

Stata dasturida internet saytidan ma`lumotlarni yuklash ham mumkin. Buning uchun 

quyidagi buyruqni kiring: 

use http://www.stata.com/texts/s4poe4/food 

O`zgaruvchilar oynasida ikkita parametr ro`yxatga kiritiladi: Y va X izohi bilan birga. 

O`zgaruvchilar Turi va Formati haqida boshqa ma`lumotlar ham paydo bo`lishi mumkin. 

Biz ustunlarni to`ldirish uchun tanladik. 

http://www.stata.com/texts/s4poe4/food


 
 

2.1.2. Ma`lumotlarni tasvirlash va ro`yxatlash 

Har bir yangi masalani boshlashdan oldin ma`lumotni ko`rib tekshirib chiqish kerak. 

Buyruqlar oynasiga quyidagi buyruqni kiriting: 

describe 

Ushbu o`zgaruvchilar haqida ko`proq ma`lumot olish uchun Buyruqlar oynasida help 

describe buyrug`ini kiriting. Oddiy sarlavha uchun hech narsa talab qilinmaydi, shuning 

uchun OK tugmasini bosing. 

 
Yuqoridagi ma`lumotlar fayli food_exp.dta haqida umumiy ma`lumot. Biz 

ma`lumotlarimizni tekshiramiz. Ma`lumotlar brauzeri (Data Editor) dan foydalaning. 

 
Ma`lumotlar qiymatlarini ko`rish imkonini beruvchi elektron ko`rinishi ochiladi. 

 



Data Editor (Browser)ni yopish uchun yuqoridagi “x” tugmasini bosing. Agarda siz u 

ma`lumotlarni chop qilishni yoki ba`zilarini ro`yxatlamoqchi bo`lsangiz yuqoridagi menu 

oynasidan Data > Describe data > List data ni bosing. 

 
Ochilgan dialog oynasida, o`zgaruvchini tanlang va Natijalar oynasida barcha 

ma`lumotlarni ro`yxatlash uchun OK tugmasini bosing. Stata buyrug`i ro`yxatlash. 

Ro`yxatlash buyrug`i sintaksisi quyidagicha: 

list [varlist] [if] [in] [, options] 

Muayyan o`zgaruvchilar qiymatlarini ro`yxatlash uchun o`zgarmaydigan nomlarini 

kiriting. Ro`yxatlangan qiymatlar oralig`i muayyan chiziqlarni ko`rsatish uchun mantiqiy 

"if" yoki "in" yordamida o`zgartirilishi mumkin. Misol uchun: 

list in 1/5 

list Y in 1/5 

list Y if X <= 360 

Natijalar oynasida quyidagilarni ko`rsatadi: 

    
Natijalar oynasi to`lsa, siz –more- so`zini ko`rasiz va ko`proq ma`lumotni ko`rish 

uchun uni bosishingiz kerak shunda barcha ma`lumotlarni topa olasiz. Bu –more- so`zi 

pauzani bildiradi. Yana bosing yoki bo`sh joyni bosing. Stata log faylini ishga tushurgandan 

keyin set more off buyrug`ini kiritgan bo`lsa, pauza xususiyatini o`chirib qo`yadi. 

 

2.2. Ma`lumotlarning tahliliy statistikasi  

Keling, ma`lumotlarning ta`rif faylida bildirilgan bir xil xulosa statistik qiymatlarga 

ega ekanligini tekshiring. Yuqoridagi menyulardan foydalanib ishlating. 

Statistics > Summaries, tables, and tests > Summary and descriptive 

statistics > Summary statistics 

Natijada muloqot oynasidagi ma`lumotlar to`plamidagi barcha o`zgaruvchilar bo`yicha 

abstrakt statistika uchun o`zgaruvchilarni tanlang va OK tugmasini bosing. Bundan tashqari, 

dialog oynasini ochish uchun db summarize yoki db su buyruqlarini kiritishingiz ham 



mumkin shunda dialog oynasi paydo bo`ladi. Yoki buyruqlar oynasida quyidagi buyruqni 

kiriting: 

Summarize 

 
Xulosa statistika buyrug`i sintaksisi quyidagicha: 

summarize [varlist] [if] [in] [weight] [, options] 

Asosiy variant bizga batafsil abstrakt statistikani olish imkonini beradi. Stata buyrug`i 

oynasida quyidagini kiriting: 

summarize Y, detail 

 
Natijalar oynasida ma`lumotlarni eng ko`p miqdori, eng kichik va eng katta kuzatishlar, 

kuzatuvlar soni (Obs) va e`tiborga olinmaydigan WGT summasi ko`rsatilgan. Stata siz 

tushunmagan ko`p narsalarni e`lon qiladi. Haqiqat siz bilgan narsalarni aniqlashga qodir. 

Misol uchun, natijalar o`z ichiga quyidagilarni oladi: 

 
Food_exp o`zgaruvchisi uchun xulosa statistikasi. 

- O`rtacha qiymat,  𝑦̅ = ∑ 𝑦𝑖 𝑁⁄  

- Std. Dev. Variantsning kvadrat ildizlari bo`lgan namunali standart og`ish 

- Oddiy variatsianing turi,  𝑣𝑎𝑟(𝑦) = ∑ (𝑦𝑖 − 𝑦̅)2 𝑁 − 1⁄  

Skewness va Kurtosis qiymatlari keyinroq muhokama qilinadi. 

 



2.3. Ma`lumotlar asosida scatter diagramsini yaratish usullari 

Oddiy regressiya modelida ma`lumotlar qiymatlarini Scatter diagramasida chizish 

muhimdir. Stata ochiladigan menyusida Graphics> Twoway graph (scatter, line, etc.) ni 

tanlang. Qo`shimcha tafsilotlarni bilish uchun buyruqlar oynasiga help twoway buyrug`ini 

kiriting. 

 
Muloqot oynasida Create tugmasini bosing. 

 
Natijada paydo bo`lgan dialog oynasida Basic plots, Scatter ni tanlab, keyin 

ochiladigan o`qlarni foydalanib, Y o`zgaruvchisini (vertikal o`q) va X o`zgaruvchisini 

(gorizontal o`q) tanlang.  

 
Submit tugmasini bosganingizda, Scatter diagrammasi yaratiladi. Stata buyruqlar 

oynasiga quyidagi buyruqni kiritib yaratsa ham bo`ladi. 

twoway (scatter Y X) 

Agar Accept tugmasini bossangiz Plot-1-buyruq belgilari oynasida paydo bo`ladi va 

OK-tugmasini bosganingizda grafika yaratiladi. 

Grafikni stata grafik kengaytmasi * .gph-dan foydalanib ya`ni diskda standart 

katalogga saqlash uchun 

Grafik nomeri 



graph save food1, replace 

Grafikni va saqlashni save opsiyasidan foydalanib, bir qadamda bajarish mumkin 

twoway (scatter Y X), saving(food1, replace) 

Diskni saqlashning o`rniga xotiraga nom variantini ishlatishingiz ham mumkin. Agar 

siz laboratoriya sharoitida bo`lsangiz, bu qulay bo`lishi mumkin. 

twoway (scatter Y X), name(food1, replace) 

 

Grafikni takomillashtirish 

Grafikni kuchaytirish uchun 1-satrda dialog oynasida Accept ni bosing. Grafika dialog 

oynasida bu Plot 1 deb ataluvchi plot ta`rifi yoki profilini yaratadi.  

 
Y o`qi yorlig`ini bosing. Natijada dialog oynasidan quyidagini tanlang. 

 
Bir nechta variant mavjud, ammo vertikal o`qning oralig`ini belgilaylik. 

 
 

Range / Delta ni bosing. Xulosa statistikasidan Y ning minimal va maksimal 

qiymatlarini ko`rgandik. Ma`lumotlar butunligini ko`rishimiz uchun Minimal qiymat 600 

va Eng yuqori 1200 qiymatini kiriting. Delta – o`qlar uchun o`lchov birliklari - 

belgilanadigan belgilar orasidagi bo`shliq. Ushbu qiymatini 100 ga to`g`rilang. Accept 

tugmasini bosing. 

Ushbu jarayonni X o`qi uchun maksimal qiymat 370 va Delta 50 dan foydalanib 

takrorlang. Accept tugmasini bosing. 



 
Grafikga nom qo`shish uchun Twoway Graph dialog oynasidagi Titles yorlig`ini 

bosing. 

 
Grafik yaratish va oynani yopish uchun OK tugmasini bosing. Bu Y-o`qi va X-o`qi 

bilan chiroyli nuqtalarni ishlab chiqaradi va ma`lumotlar to`plamidagi o`zgaruvchilar 

izohlari bilan belgilanadi. 

 
Ushbu nuqtali grafikni yaratish uchun foydalaniladigan Stata buyrug`i quyidagicha: 

twoway (scatter Y X), ytitle(Consumer expenditure) /// 

ylabel(600(100)1200) xtitle(Expenditure on Food) /// 

xlabel(150(50)370) title(Consumer exp & food exp) 

Ushbu buyruqdagi "///" belgilar keyingi qatordan buyruqni davom ettiradi. Buyruqlar 

uzunligi yoki buyruqning muayyan qismlaridan keyin ularga izohlar kiritilishi foydalidir. 

Fikrlarni ushbu belgilar orqali "/ * .... * / " ifodalaniladi va bu foydalidir, chunki u har qanday 

joyga joylashtirilishi mumkin va tarkib Stata dasturi tomonidan e`tiborga olinmaydi. 

Muqobil sharhning buyruqlarini muhokama qilish uchun help comments buyrug`ini 

kiriting. 

twoway (scatter Y X), oddiy nuqtali grafik uchun ishlatiladigan buyruqlar. 

Bu vergul muhim ahamiyatga ega va qo`llaniladigan variantlarni bildiradi. 
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ylabel(600(100)1200) Y o`qi oralig`ini, 600 dan 1200 gacha va 100 asosiy nuqtalar 

oralig`ini bildiradi. 

xlabel(150(50)370) 150 - 370 oralig`ini belgilaydi va X o`qi uchun 50 sonini oralig` 

hisoblanadi. 

title(Consumer exp & food exp) asosiy grafik nomini bildiradi. 

Yana bir marta siz ikkita buyruqqa saqlash parametrini qo`shishingiz yoki xotiraga 

saqlash uchun variant nomini ishlatishingiz yoki grafikni saqlash buyrug`idan 

foydalanishingiz mumkin. Grafikni saqlash buyruqlaridan ushbu bobda faylda 

foydalanamiz. 

 

2.4. STATA dasturida regression model yaratish usuli 

Oddiy chiziqli regressiya modeli:  

𝑦 = 𝛽1 + 𝛽2𝑥 + 𝑒 

Asosiy omil, y (consumer expenditure) va ta`sir etuvchi omil x (expenditure on 

food) bo`yicha ma`lumot berilgan holda, noma`lum parametrlarni topish va baholash uchun 

Stata dasturidan foydalanamiz. Regression tahlilni amalga oshirish uchun yuqoridagi menu 

dan foydalanilgan holda quyidagicha amalga oshiramiz: 

Statistics > Linear models and related > Linear regression 

 
Regress - Linear regression muloqot oynasida Y -ga bog`liq bo`lgan o`zgaruvchini 

tanlang. Bu esa chap tomonda joylashgan regressiya modelidagi asosiy omildir. Ta`sir 

etuvchi (o`ng tomon) o`zgaruvchisi sifatida X ni tanlang (yoki kiriting). So`ngra OK 

tugmasini bosing. Stata dasturi avtomatik tarzda hisob-kitoblarni amalga oshiradi.  

 
Shu bilan bir qatorda, quyidagi buyruq orqali amalga oshirish ham mumkin. 

regress depvar [indepvars] [if] [in] [weight] [, options] 

Help regress buyrug`i orqali qo`shimcha ma`lumotga ega bo`lasiz. Bu shuni 

ko`rsatadiki, asosiy omil depvar birinchi bo`lib joylashtiriladi, keyin ta`sir etuvchi 

o`zgaruvchi yoki o`zgaruvchilar (ko`p ommilli regressiya uchun), indepvars lar kiritiladi. 

Agar xohlasangiz, siz if yoki in bilan cheklash, kuzatishlardagi hajmini belgilash yoki 

ulardan foydalanish imkoniyatlarini qo`llashingiz mumkin. Ushbu variantlarni (if va in 

buyruqlarini) kelgusi boblarda ko`proq muhokama qilamiz. 



Iste`mol va oziq-ovqat xarajatlari uchun oddiy regressiya buyrug`i mavjud 

regress Y X 

buni qisqartirilishi ham mumkin 

reg Y X 

Natijalar oynasida regress uchun Stata buyrug`i berilgan va regression natijalari 

ko`rsatiladi. Bu narsalarni hammasini o`rganamiz, ammo hozircha Y va Coef deb 

nomlangan birinchi ikkita ustunni ko`rib chiqamiz. 

Birinchi ustunda o`zgaruvchilarning nomlari berilgan. Kompyuter dasturlari biz "𝜷𝟏" 

va " 𝜷𝟐 " deb chiziqli regressiya tenglamasida o`zgaruvchilarning nomlarini belgilab 

olganimizni bilmaydi va shuning uchun "𝜷𝟏 " va "𝜷𝟐 " lar o`rniga o`zgaruvchilarning 

nomlari bilan ifodalaydi. Stata birinchi navbatda tenglama parametrlarni Coef. so`zi ostida 

beradi. Y-endogen _cons, ya`ni "doimiy" yoki "asosiy omil" deb nomlanadi, bu y-endogen 

uchun yana bir umumiy nom. 

 
 

2.4.1. Hisoblangan qiymat (𝒀̂) va qoldiqlar 

Hisoblangan y qiymatlari va qoldiqlarni "postestimation" buyruqlaridan foydalanib 

topiladi. Ularni "postestimation" parametri deb atashadi, chunki ular regressiya modelini 

baholashadi. Bunga qo`shimcha ma`lumotni, help regress buyrug`ini kiritgandan so`ng 

postestimation parametrlari havolasini oynaning o`ng tomoni yuqorisida va burchagida 

ko`rishingiz mumkin. 

 



Stata dasturidagi yuqoridagi menu lar orqali bajarish yo`li: 

Statistics > Postestimation > Predictions, residuals, etc. 

 Statistics menu sini bosing so`ngra: 

 
Paydo bo`lgan muloqot oynasida bir nechta muqobillar mavjud. Hisoblangan qiymatni 

(𝒀̂) hisoblash uchun Linear prediction ni belgilang va hisoblangan qiymatlar nomini 

kiriting, so`ngra Ok tugmasini bosing. 

 
Qoldiqlarni olish uchun, 

𝒆𝒊̂ = 𝒚𝒊 − 𝒚𝒊̂ =  𝒚𝒊 − 𝒃𝟏 − 𝒃𝟐𝒙𝒊 

dialog oynasini qayta oching, Residuals (equation-level scores) ni belgilang va 

qoldiqlarning nomini kiriting ya`ni  ehat deb so`ngra Ok tugmasini bosing. 

 
Ushbu buyruqlar o`zgaruvchilari oynasida ko`rinadi ya`ni ikkita yangi o`zgaruvchi, 

yhat va ehat paydo bo`ladi. 

 

hisoblangan 

qiymatlar nomi 

qoldiq qiymatlar  

nomi 



Ma`lumotlar Brauzerini (Data editor (Browse)) tanlab, yoki quyidagi buyruqni 

ishlatib ushbu qiymatlarni tekshiring 

browse 

 
Hisoblangan 𝑦̂  qiymatlari va qoldiqlarni hisoblaydigan Stata komandalari asosiy 

predict buyrug`i yordamida taxmin qilinadi. Ma`lumotlar brauzerni yoping va buyruqlar 

oynasiga quyidagini kiriting:  

help predict 

Predict buyrug`ining asosiy sintaksi: 

predict [type] newvar [if] [in] [, single_options] 

Nimalar kerak o`zgaruvchining nomi, newvar va turi. Hisoblangan y qiymatlarini olish 

uchun "x marta b" uchun qisqa bo`lgan xb- qisqartmani ishlating. 

predict yhat, xb 

Bashoratlarni olish, aslida, bu buyruq uchun amrimahol, shuning uchun biz 

quyidagidan foydalangan afzal: 

predict yhat 

Qolgan qoldiqlarni olish uchun options ga residuals dan foydalaning. Oziq-ovqat sarf-

xarajatlari modelli uchun bu:  

predict ehat, residuals 

Qoldiqlarni bir necha turlarda yozish mumkin minimal darajasiga qisqartmasi r yoki 

res yoki resid ga o`xshab biroz qisqartirilishi mumkin. 

 

2.4.2. Elastiklikni hisoblash 

Parametr tahminlarini va o`zgaruvchilar uchun umumiy statistikani hisobga olgan 

holda, iste`mol sarf-xarajatlarining oziq-ovqat xarajatlariga nisbatan moslashuvchanligi 

kabi boshqa miqdorlarni osonlikcha hisoblashimiz mumkin. 

𝜀 ̂ =  𝑏2 ∙
𝑥̅

𝑦̅
= 3.2321 ×

296.33

971.48
= 0.98 

Stata dasturining postestimation komandalaridan biri bu elastiklikni avtomatik 

ravishda hisoblash imkonini beradi. Bu quyidagicha: 

Statistics > Postestimation > Marginal effects. 



 
Ochilgan muloqot oynasida Elasticities va Variable ni tanlang. Bizning oddiy 

regressiya modelimizda bitta o`zgaruvchi ya`ni X ni kiriting. Elastiklikni baholash uchun 

At menu sini tanlang va All covariates at their means in the sample ni belgilang. 

 

 
Natijalar oynasida biz shartli marginal ta`sirlarni ko`ramiz: 

 
Margins dialog oynasi juda kuchli va siz tushunmaydigan hisob-kitoblarni amalga 

ham oshiradi. Biz uni bir nechta nuqtalar qilish uchun taqdim etamiz. Iqtisodiy tahlilda bir 

o`zgaruvchining natijasi boshqa bir o`zgaruvchiga ta`sirini ko`rasiz, shuningdek barchasi 

o`zgarmas bo`lsa bu marginal effect deb ataladi. Regression modeldan, bu qiyalik 



parametridir va oddiy regresyon modeli hosilasi dy/dx hisoblanadi. Stata bu qiymatni 

murakkab modellarda ham hisoblab chiqadi va biz ushbu xususiyatga keyinroq ko`rib 

chiqamiz.  

Linear (to`g`ri chiziqli) regressiya modelida elastiklik quyidagicha: 

𝜀 =
∆𝑦/𝑦

∆𝑥/𝑥
=

∆𝑦

∆𝑥
∙

𝑥

𝑦
 

Deltani lotin shaklida “d” harfi bilan o`zgartiring. 

𝜀 =
𝑑𝑦/𝑦

𝑑𝑥/𝑥
=

𝑑𝑦

𝑑𝑥
∙

𝑥

𝑦
= 𝛽2

𝑥

𝑦
 

To`g`ri chiziqli regressiya modelida dln (y) = dy/y va dln (x) = dx/x qilib hisoblanadi.  

𝜀 =
𝑑𝑙𝑛(𝑦)

𝑑𝑙𝑛(𝑥)
=

𝑑𝑦/𝑦

𝑑𝑥/𝑥
 

Regressiyadan keyin ushbu elastiklik uchun Stata post-estimation buyrug`i 

quyidagicha: 

margins, eyex( income ) atmeans 

Stata faqat elastiklik haqida xabar bermasdan, shuningdek bu miqdor uchun standart 

xatolikni va ishonch oralig`ini hisoblaydi. Bu miqdor hisoblab chiqilgan oziq-ovqat 

mahsulotlariga xarajat qiymatini ko`rsatadi, bu esa namunadagi o`rtacha qiymatdir. Odatda 

moslashuvchanlik, "vositalar nuqtasida" ( 𝑥̅ , 𝑦̅ )=(296.33;971.48)  da hisoblab chiqiladi, 

chunki u regression yo`nalishdagi vakolatli nuqtadir. 

Bir nuqtada elastiklikni hisoblash o`rniga, y va x ning har bir qiymatida 

moslashuvchanlikni topishimiz va keyinchalik bu miqdorni barcha kuzatishlar bo`yicha 

o`rtacha hisoblashimiz mumkin. Bunga O`rtacha marginal ta`sir (Average marginal effect) 

deyiladi, bu holda o`rtacha elastiklik. Ya`ni quyidagicha 

𝐴𝑀𝐸 = 𝜀̅ =
1

𝑁
∑ 𝑏2

𝑥𝑖

𝑦𝑖

𝑁

𝑖=1

 

Stata dasturi quyidagicha hisoblaydi 

𝐴𝑀𝐸̂ =
1

𝑁
∑ 𝑏2

𝑥𝑖

𝑦̂𝑖
=

1

𝑁
∑ 𝑏2

𝑁

𝑖=1

(
𝑥𝑖

𝑏1 + 𝑏2𝑥𝑖
)

𝑁

𝑖=1

 

Bu miqdorni topish uchun Stata margins buyrug`ida ilgari ishlatilgan "atmeans" so`zi 

ishlatmaydi. 

margins, eyex( income ) 

Natijalar, endi yuqoridagi kabi, shartli marginal ta`sirlardan ko`ra o`rtacha marginal 

ta`sirlar farqlidir. 



 
Ushbu hisobni tekshirishimiz mumkin. Regressiyadan so`ng, Stata xotirasida 

hisoblangan koeffitsientlarni saqlab qoladi. Regression koeffitsientlari _b[varname] deb 

nomlanadi. Iste`mol sarfini kamaytirgandan so`ng, taxminan _b [X] sifatida saqlanadi. 

Keyinchalik namunadagi har bir kuzatuv uchun baholangan moslashuvchanlikni hisoblash 

mumkin. Bu esa quyidagicha buyruq orqali amalga oshadi: 

generate elas = _b[X]*X/yhat 

O`rtacha elastiklik 

summarize elas 

Natijalar oynasida quyidagi paydo bo`ladi:  

 
Ushbu natijalarda Std. Dev. standart og`ishni anglatadi. Margins buyrug`i Delta-

metod Std. Err. deb atalgan narsalarni ishlab chiqaradi. Ular bir xil emas. Delta usuli 

Principle of Econometrics-e4 kitobining 5-bobida keltirilgan. 

 

2.4.3. Hisoblangan regression model chizig`ini grafikda joylashtirish 

Hisoblangan regressiya chizig`ini tuzish uchun Stata dasturining yuqoridagi 

ochiladigan menu sidan Graphics > Twoway graph (scatter, line, etc.)  tanlang. Agar siz 

bu mashg`ulotni davom ettirmoqchi bo`lsangiz va nuqtali grafikni 2.3-bo`limga kiritgan 

bo`lsangiz, u holda 1-grafikda nuqtali diagrammasi allaqachon mavjud. Biz chiziqli prognoz 

uchun yangi grafik yaratamiz. Create tugmasini bosing. Plot 2 dialog oynasida Fit plots 

tanlang va Linear prediction bilan birgalikda Y o`zgaruvchi (consumer exp) va X 

o`zgaruvchi (food exp)sini kiriting.  



 
Accept tugmasini bosing. Titles so`zini ustiga bosib Plot-2 ni nomni o`zgartiring ya`ni 

yangi nom kiriting. Plots menu siga qayting. Submit tugmasini bosish orqali grafikani 

yaratadi va grafikni ko`rsatadi. 

 

 
Qachonki bir nechta grafiklar mavjud va xotirada bo`lsa, Stata bir grafini boshqasiga 

joylashtiradi. Tayyorlangan grafik:  

Linear 

prediction 

-

grafikning 

turi 

Bir necha 

grafiklar 

Submit tugmasi 

grafikni paydo qiladi 

ammo dialog oynasi 

yopilmaydi 

OK tugmasi grafikni 

paydo qilib dialog 

oynasini yopadi 



 
Buyruqlar oynasida biz quyidagi buyruqni kiritsa ham bo`ladi: 

twoway (scatter Y X)                      ///            /* basic plot control */ 

              (lfit Y X),                           ///            /* add linear fit */ 

              ylabel(600(100)1200)        ///            /* label Y axis */ 

              xlabel(150(50)370)            ///            /* label X axis */ 

              title(Fitted Regression Line)     /* graph title */ 

 

2.4.4. Variatsiya va kovarvatsiyani hisoblash 

Regressiya koeffitsientlaridan tashqari yana bir muhim parametr - bu variatsion xatolik 

atamasi, 

𝑣𝑎𝑟(𝑒𝑖) = 𝜎2 = 𝐸[𝑒𝑖 − 𝐸(𝑒𝑖)]2 = 𝐸(𝑒𝑖
2) 

Ushbu parametrni kiritish quyidagicha: 

𝜎̂2 =
∑ 𝑒̂𝑖

2

𝑁 − 2
 

Yuqoridagi 𝑒̂𝑖 = 𝑦𝑖 − 𝑦̂𝑖 = 𝑦𝑖 − 𝑏1 − 𝑏2𝑥𝑖  bu so`nngi kvadrat qoldiqlari. "2" soni - bu 

𝛽1  va  𝛽2  regression tenglamaning parametrlari soni. Stataning regressiya buyrug`idagi 

natijaning yuqori qismi yani quyidagi bu jadval Analysis of Variance berilgan. 

 
Residual qatoriga e`tibor bering. SS bilan belgilangan ustunda kvadrat yig`indisi 

mavjud. 186.620714 qiymati kvadratlar qoldiqlarining yig`indisidir. 

𝑆𝑆𝐸 = ∑ 𝑒̂𝑖
2

𝑁

𝑖=1

= 𝑆𝑆 𝑅𝑒𝑠𝑖𝑑𝑢𝑎𝑙 
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df bilan belgilangan ustun bu (residual) erkinlik darajasi bo`lib, u bu holda N-2 = 4 

bo`ladi. Modelning erkinlik darajalari 1, qaysiki biri o`zgaruvchi soni bo`lsa, boshqa biri bu 

parametrlar soni ya`ni 𝛽2 . Ustun boshi ya`ni MS o`rtacha kvadratni anglatadi. Kvadrat 

qoldiqlarining o`rtacha qiymati taxminiy xato variatsiasidir. 

𝜎̂2 =
∑ 𝑒̂𝑖

2

𝑁 − 2
= 𝑀𝑆 𝑅𝑒𝑠𝑖𝑑𝑢𝑎𝑙 = 46.6551785 

Jadvalning boshqa qismlarini keying boblarda tushuntiriladi. 

Regressiya tenglamasini tuzgandan so`ng, bu regressiyaga bog`liq bir necha statistik 

hisob kitoblar bor, lekin Stata dasturi ularni hisoblab ko`rsatmaydi. Oziq-ovqat 

mahsulotlarini sarf qilish modeli uchun eng kichkina kvadratlar variatsiasi va kovarvatsia: 

𝑣𝑎𝑟(𝑏1)̂ = 𝜎̂2 [
∑ 𝑥𝑖

2

𝑁 ∑(𝑥𝑖 − 𝑥̅)2
] = 180.35254 

𝑣𝑎𝑟(𝑏2)̂ =
𝜎̂2

∑(𝑥𝑖 − 𝑥̅)2
= 0.00196526 

𝑐𝑜𝑣(𝑏1, 𝑏2)̂ = 𝜎̂2 [
−𝑥̅

∑(𝑥𝑖 − 𝑥̅)2
] = −0.58237347 

Bularni estat buyrug`i yordamida ko`rish ham mumkin. Buyruqlar oynasiga quyidagini 

kiriting: 

help estat 

Variatsiani va kovarvatsiani hisoblash uchun quyidagini kiritish kerak:  

estat vce 

Natijada, regressiya koeffitsientlarining hisoblangan variatsiasi diagonaliga joylashgan 

va regressiya koeffitsientlarining hisoblangan kovarvatsiasi "diagonal bo`lmagan" mavjud 

jadval ko`rsatadi. Stata hisoblagan matritsasining yuqori chap burchakdagi 𝑏2 

parametrining variatsiasidir. 

 

 
Variatsianing kvadrat ildizlar koeffitsientlari standart xatolikning hisoblangan 

koeffitsientidir. 

𝑠𝑒(𝑏1) = √𝑣𝑎𝑟(𝑏1)̂ = 13.42954 



𝑠𝑒(𝑏2) = √𝑣𝑎𝑟(𝑏2)̂ = 0.0443313 

Ular regressiya natijasida ko`rsatiladigan ya`ni Stata dasturi tomonidan avtomatik 

ravishda chiqariladigan Std.Err deb izohlanadi. 

 
 

2.5. Regression modelning prognoz qiymatlarni olishda stata dasturidan foydalanish 

Iste`mol va oziq-ovqat sarf-xarajatlari modeliga asoslanib, oziq-ovqat xarajatlari uchun 

yilda 20 dollar xarajat keltiradigan taxminiy qiymatini olaylik. 

𝑦𝑖̂ = 13.696 + 3.21𝑥𝑖 = 13.696 + 3.21(20) = 77.896 

Ma`lumotlar fayliga to`liq bo`lmagan kuzatuv qo`shish orqali biz Stata dasturini 

ishlashda davom ettiramiz. Stata uskunalar panelidan Data Editor tugmasini bosing. 

 
Bu ma`lumotlar bazasi kabi elektron jadval ko`rinishini ochib beradi, xuddi Data 

Browser ga o`xshash, lekin bu Data Editor farq qiladi unda ma`lumotlarni o`zgartira 

olamiz. 6- ya`ni oxirgi kuzatish natijasi uchun pastga tushing, 7-qatorda daromad uchun 

yachekani tanlang. "Formula bar" oynasida 20 qiymatini kiriting va Enter tugmasini 

bosing. 

 
Data Editor endi daromadning 7-kuzatish natijasi uchun 20 qiymatga ega ekanligini 

ko`rsatadi, ammo boshqa qiymatlar "." ekanini ko`rsatadi. Stata da "." belgisi bir davr 

raqamli ma`lumotlar qiymati yo`qligini bildiradi. Data Editor oynasini yopish uchun x-

tugmasini bosing. Shu bilan Stata buyruqlar oynasiga quyidagi buyruqlar orqali amalga 

oshirsa ham bo`ladi. 

edit 

set obs 7 



replace X = 20 in 7 

Ushbu set buyrug`i ko`plab tizim parametrlarini boshqaradi, kuzatishlar sonini 

qo`shadigan yordamchi buyruq ham hisoblanadi. Buyruqning joyi Data > Create or change 

data > Change contents of variable orqali ham amalga oshirish mumkin. Replace 

buyrug`ining sintaksisi: 

replace oldvar = exp [if] [in] [, nopromote] 

X ning 7-qatoriga qiymati 20-sonli qiymatni joylashtirdik. Bu buyruqlar haqida 

ko`proq ma`lumot olish uchun help set va help replace orqali ega bo`lishingiz mumkin. 

Bashoratli yoki hisoblangan qiymatlarni allaqachon yhat deb topib olgandik,shuning 

uchun biz  "yhat0" deb nomlab qiymatni topamiz. Predict buyug`idagi xb parametrini 

tushurib qoldirib topishimiz mumkin. 

predict yhat0 

Kuzatishdagi 7-X va yhat0 ma`lumotlarini ro`yxatlash. 

list X yhat0 in 7 

Natijalar oynasida ko`rishingiz mumkin 

 
Har yilda $ 20 oziq-ovqat mahsulotlar xarajati uchun kutilgan yillik iste`mol xarajatlari 

yhat0 qiymatida hisoblab ko`rsatilgan. 

 

Stata dastur ma`lumoti faylini saqlash  

Stata ma`lumot faylini saqlash uchun File >Save as ketma-ketligini amalga oshiring. 

 
Ma`lumotlar faylini chap02.dta kabi yangi nom bilan saqlang. Stata dasturida quyidagi 

buyruq orqali amalga oshiriladi. 

save chap02.dta 

Oxirgi qadam sifatida log faylini yopasiz. 

log close 

 

 

II bob mavzularini mustahkamlash uchun savollar 

1. Klasik chiziqli modelni yaratish uchun ma`lumotlarini yuklash ketma ketligi qanday? 

2. Kundalik log faylni ishga tushirish va yopish uchun qanday buyruq amalga oshiriladi? 



3. Stata xotirasini bir vaqtning o`zida yangi ma`lumotlar faylini ochish hamda tozalash 

zarur bo`lsa, qanday buyruq kiritiladi? 

4. Stata dasturida internet saytidan ma`lumotlarni yuklash uchun qanday amal bajarish 

lozim? 

5. Xulosa statistika buyrug`i sintaksisi burug’i qanday beriladi? 

6. Oddiy regressiya modelida ma`lumotlar qiymatlarini qanday diagramma orqali 

chizish mumkin? 

7. Stata buyruqlar oynasida Scatter diagrammasini yaratish qaysi quyruq orqali amalga 

oshiriladi? 

8. Oddiy chiziqli regressiya modeli qanday formula orqali ifodalanadi? 

9. Stata dasturida elastiklikni avtomatik ravishda hisoblash qanday ketma ketlik asosida 

amalga oshiriladi?  

10.  marginal effect deganda nimani tushunasiz? 

11.  Linear (to`g`ri chiziqli) regressiya modelida elastiklik qanday ifodalanadi? 

12.  Hisoblangan regressiya chizig`ini tuzish qanday amallar orqali bajariladi? 


